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ВВЕДЕНИЕ 
 

В настоящее время компьютерная графика и мультимедийные техноло-
гии активно используются на всех этапах образовательного процесса. Форми-
рование профессиональных компетенций в области компьютерной графики и 
мультимедиа, позволяющих реализовать фундаментальный дидактический 
принцип наглядности в обучении на качественно новом уровне, необходимо 
для будущих учителей математики и информатики, способных эффективно 
применять средства информационных и коммуникационных технологий в 
процессе осуществления своей профессиональной деятельности.  

Задачами изучения дисциплины «Компьютерная графика и мультиме-
диа» являются: овладение понятийным аппаратом компьютерной графики и 
мультимедиа, изучение технологий создания и обработки графической и муль-
тимедийной информации и способов её хранения, приобретение навыков ра-
боты с современными графическими программными средствами. 

В результате изучения учебной дисциплины «Компьютерная графика и 
мультимедиа» студент должен знать виды компьютерной графики, основ-
ные понятия двумерной (растровой, векторной) графики, аппаратное и про-
граммное обеспечение для работы с графикой и мультимедиа, виды и при-
емы анимации. По результатам выполнения лабораторных работ студент 
должен уметь решать типовые задачи обработки графической информации, 
выполнять построение схем и чертежей, производить обработку звука и ви-
део, создавать мультимедийный контент, а также владеть методами созда-
ния и обработки растровых изображений, деловой и инженерной графики, 
технологиями создания мультимедийного контента, методами создания и 
обработки трехмерных изображений. 

Методические рекомендации «Основы компьютерной графики» состав-
лены для выполнения студентами специальности 1-02 05 01 «Математика и 
информатика» лабораторных работ по дисциплине «Компьютерная графика и 
мультимедиа» и ориентированы на студентов-иностранных граждан, а также 
всех студентов факультета математики и информационных технологий. Ос-
нову данных методических рекомендаций составляют материалы, разработан-
ные авторами и использованные при проведении лабораторных занятий по 
компьютерной графике. 

Каждая лабораторная работа содержит краткую справочную информа-
цию, перечень практических заданий для самостоятельного выполнения 
студентами, творческие задания. Все этапы выполнения заданий подробно 
описаны и иллюстрированы.  

Данное издание также может использоваться для самостоятельной ра-
боты, индивидуального и дистанционного обучения.  
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ЛАБОРАТОРНАЯ РАБОТА № 1 
Основные инструменты редактора PhotoShop 

 
Цель: знакомство с инструментами группы «Выделение», градиент, 

кисть; работа со слоями; трансформирование изображений; добавление ки-
сти в набор. 

Описание работы 
Создайте новый документ со следующими настройками: 
 

 
 

Новый документ имеет пока один прозрачный слой. 
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На Панели инструментов выбрать инструмент Овальная область. 
 

 
 
Нарисовать овал на Слое 1. Если вы хо-

тите, чтобы получился правильный круг, при 
рисовании удерживайте нажатой клавишу 
Shift. Нарисованная фигура изображается «бе-
гущей» пунктирной линией.  

Выбрать инструмент Градиент 
(Gradienttool), который позволяет создать посте-
пенно изменяющееся наложение нескольких 
цветов. 
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Выбрать переход цвета от черного к белому и настроить цвета следую-
щим образом: темный – 8225f5, светлый – 6ca8f3.  

 

Цвета можно выбрать самостоятельно. 
Установить Радиальный градиент (Radial gradient) и выбрать Инверсию 

цветов (светлый и темный цвета градиента поменяются местами). 
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Не снимая выделе-
ние овала, провести ли-
нию градиента слева-
сверху, вправо-вниз, вы-
деленная овальная об-
ласть будет залита гра-
диентом. 

 

Уменьшить, сжать 
границы выделенной области командой Выделение → Модификация → 
Сжать (Select → Modify → Contract). 

Установить радиус 
сжатия, например, 20 
пик-селов (можно подо-
брать значения само-
стоятельно). 

 
 
 
 
 
 
 
 
 
 
 
 

Ре
по
зи
то
ри
й В
ГУ



9 

Изображение выделенной об-
ласти изменилось – уменьшилось 
в размере. 

Выбрать более светлые цвета 
градиента, например, фиолетовый – 
a975e9, голубой – 7ac7ee. 
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Применить градиент к вы-
деленной области.  

Командой Ctrl+D снять 
выделение. 

Создать новый слой. Ис-
пользуйте кнопку Создать но-
вый слой (Create new layer) 
справа внизу. 

Переименовать слои сле-
дующим образом: Слой 1 – 
Шарик, Слой 2 – Глаз. 

 

Сделать активным слой 
Глаз. Используя инструмент 
Овальная область, нарисовать 
овал для глаза.  

 
Выбрать инструмент Гра-

диент. Настроить цвета гради-
ента более светлых оттенков, 
например, фиолетовый – a79eb2, 
голубой – c3ced4. 
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Применить градиент к выделенной области.  
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Уменьшить, сжать границы выде-
ленной области командой Выделение → 
Модификация → Сжать (Select → 
Modify → Contract), как описано 
выше, и выбрать радиус сжатия 20 
пикселей. 

Снова изменить цвета градиента 
на более светлые (близкие к белому), 
фиолетовый – dedae3, голубой – fafcfd. 
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Применить градиент.  
Снять выделение области (комбинация клавиш Ctrl+D). 
Используя инструменты Заливка и Овальная область, нарисовать на те-

кущем слое зрачок глаза и блики, например, как на рисунке ниже. Для де-
тальной прорисовки мелких элементов можно пользоваться масштабирова-
нием. Цвет выбрать самостоятельно. 

Используя контекстное меню слоя (вызов меню – щелчок правой кноп-
кой мыши на строке с именем слоя) создать дубликат слоя. 
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Используя инструмент Перемещение переместить второй глаз вправо 
(можно пользоваться стрелочками вправо-влево на клавиатуре или мышью). 
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Пользуясь командой 

Редактирование → Транс-
формирование → Отра-
зить по горизонтали  
(Edit → Transform → Flip 
horizontal) выполнить от-
ражение глаза. Можно ис-
пользовать команду Редак-
тирование → Свободное 
трансформирование и вы-
полнить поворот и мас-
штабирование рисунка 
глаза. 
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Командой Ctrl+E объединить 

слои с глазами. На панели слоев 
останется два слоя. Выровнять по-
ложение глаз (при желании). 

 
Самостоятельно создать новый слой, дать ему имя Улыбка. 
 

Активизировать слой Улыбка и 
выбрать инструмент Овальная об-
ласть. Нарисовать овал, вытянутый 
вертикально.  
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Удерживая нажатой 
клавишу левый Alt, нари-
совать второй овал, кото-
рый в пересечении с пер-
вым образует улыбку. Как 
только будет отпущена 
кнопка мыши, будет вы-
полнена операция пересе-
чения областей – останется 
«улыбка». 

Самостоятельно подо-
брать оттенок цвета и закра-
сить выделенную область.  

Отменить выделение 
области. Переместить 
улыбку в нужное положение. 

 
 
 
 

 

 
Активизировать слой с именем 

Шарик. Выбрать основной цвет пипет-
кой (положение пипетки в нижней ча-
сти обводки шарика).  

Для цветов примера можно вы-
брать цвет 8225f5. 
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Выбрать инструмент Кисть 
(Brush). Настройки кисти: жест-
кая, круглой формы, размер не 
больше 20 пикселей. Кистью вы-
бранного цвета нарисовать «хво-
стик» шарика с ниточкой. 
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Задание для самостоятельной работы 
1. Создать новый слой выше всех остальных. Дать ему имя «Брови». 

Нарисовать брови так же, как рисовали улыбку. Сохранить работу в файле 
в формате .psd. 

2. Объединить все слои с фрагментами рисунка в один, соблюдая по-
следовательность наложения (иначе может оказаться, что слой или его часть 
не будут видны). 

3. Удерживая нажатой клавишу Ctrl, щелкнуть левой кнопкой мыши на 
миниатюре стоя. Всё изображение шарика должно выделиться. Добавить изоб-
ражение шарика в набор кистей редактора PhotoShop. Для этого выполнить 
команду Редактировать → Определить кисть. Снять выделение области. 

4. Создать новый слой ниже слоя с рисунком Шарика. Для слоя с Ша-
риком убрать видимость (значок глаза рядом с миниатюрой слоя). Создать 
фон для шарика на новом слое. Для этого применить заливку голубым цве-
том (небо).  

5. Создать новый слой между голубым фоном и Шариком. Используя 
инструмент Овальная об-
ласть нарисовать на нем об-
лако белого цвета (можно 
применять градиент к каж-
дому овалу, из которых со-
стоит изображение облака). 

6. Продублировать слой 
с облаком. Используя Сво-
бодное трансформирование 
изменить форму, размер и по-
ложение облака.  

7. Объединить слои с 
небом и облаками в один. 
Дать ему имя Фон. 

8. Создать новый слой 
над слоем Фон. Меняя цвет 
и размер кисти нарисовать  
5 шариков, парящих в небе. 
Пример рисунка: 

9. Сохранить результат 
в файле с именем Шарик 1. 
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Творческое задание 
1. Создать новый документ формата А4 с прозрачным фоном. 
2. Создать три слоя, назвать их «Небо», «Горы», «Море». На каждом 

слое выполнить соответствующее изображение инструментом Кисть. Для 
эффекта размытия использовать инструмент Палец. 

3. Меняя положение слоёв получить разные картинки: море перед го-
рами, море за горами. Сохранить их в формате .jpeg. 

4. Добавить слои с изображениями солнца, птиц, облаков и т. д. Сохра-
нить документ в формате редактора и в формате .jpeg. 

 
 

ЛАБОРАТОРНАЯ РАБОТА № 2  
Рисунки в коллажной технике. Создание надписей 

 
Цель: научиться создавать изображения в технике коллажа — вырезая 

и совмещая фрагменты из разных изображений; создание простейших 
надписей с использованием инструмента Текст; инструменты выделения об-
ластей рисунка; инверсия выделенной области; сохранение изображения в 
разных форматах. 

Описание работы 
Открыть в редакторе PhotoShop файл Primer2_0.jpg. Снять блокировку 

слоя (убрать замочек). Подобрать масштаб изображения. Из группы инстру-
ментов Выделение выбрать Магнитное лассо. Обвести по контуру поло-
винки оливок. Когда линия замкнётся, изображение будет выделено. 
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Используя команду Выделение → Инверсия выделить фоновое изобра-
жение. Нажать на клавиатуре Delete. 

 

 
Снять выделение. Используя инструмент Рамка обрезать картинку.  

Сохранить изображение в формате .png. 
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Открыть в редакторе PhotoShop изображение бутылки с растительным 
маслом из файла Primer2_1.jpg. Используя инструмент выделения Волшеб-
ная палочка выделить фон вокруг бутылки.  

 

 
Для того, чтобы добавить к выделению область одного цвета, необходимо 
удерживать нажатой клавишу Shift (левый). 
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Когда вся область выделена, нажать на клавиатуре клавишу Delete. 

 
Снять выделение. Небольшие погрешности выделения можно акку-

ратно удалить ластиком. 
Обрезать лишнее и сохранить изображение в формате .png. 
 
Задание для самостоятельной работы 
1. Открыть изображение из файла Primer2_2.jpg. Будем его использо-

вать в качестве фона. 
2. Продублировать изображения бутылки и половинок оливок на от-

дельные слои рисунка Primer2_2. 
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Выполнить наложение слоев, подобрать масштаб. Используя возмож-

ности трансформации (масштаб, поворот, наклон, искажение, перспектива 
и т.п.) разместить изображение бутылки на фоне оливок справа. Изображе-
ние половинок оливок скрыть. 
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3. Создать слой с текстовой надписью рекламного характера, например, 
«OliveOil — прекрасный выбор» или «OliveOil. Идеальный вкус». Офор-
мить надпись каким-либо образом: выгнуть, скрутить и т. п., применяя де-
формацию текста. 

4. Под слоем с текстом создать новый слой, на котором изобразить пря-
моугольник белого цвета (это нужно для того, чтобы текст не сливался с 
фоном). Настроить прозрачность этого слоя. 

Вернуть видимость слою с половниками оливок. 

 
 

В настройках стиля 
слоя можно выбрать тень 
или обводку для повыше-
ния читабельности тек-
ста. Расположить оливки 
поверх текста.  

5. Сохранить файл в 
формате редактора и в 
формате .jpeg. Ре
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Таким образом мы создали рекламный флаер. 

 
Творческое задание 
1. Открыть файл Ве-

точка сакуры.jpg. Снять бло-
кировку слоя (значок с изоб-
ражением замочка). 

2. Создать текстовый 
слой с надписью: 
«Goodmorning!» (гарнитура – 
VinerHandITC или True Grit 
CTT, размер – 180 пт, метод 
сглаживания – Резкое, цвет – 
зеленый). Создать деформи-
рованный текст, настроив 
деформацию в соответству-
ющем диалоговом окне:  

Применить свободное 
трансформирование, повер-
нуть текст и переместить так, чтобы наложить его как можно больше на 
изображение веточки с цветами. 

Ре
по
зи
то
ри
й В
ГУ



27 

3. Удерживая нажатой клавишу Ctrl щелкнуть по миниатюре слоя с тек-
стом. Текст выделится. Удалить слой с текстом, выделение не снимать. 

4. Инвертировать выделение командой Выделение→Инверсия. Выпол-
нить команду  меню Редактирование → Очистить. 

5. Снова инвертировать выделение. В настройках стиля слоя выбрать 
обводку малинового цвета. 

6. Инструментом Рамка выполнить обрезку изображения. Обратите 
внимание, что надпись выполнена на прозрачном слое! 

7. Сохранить надпись в формате .png. 
8. Открыть файл Foto_010.jpg. Перейти к окну с надписью, которую 

только что сделали. Продублировать слой с надписью в документ 
Foto_010.jpg. Применить свободное трансформирование к слою с надписью, 
должно получиться что-то подобное: 

 
9. Самостоятельно подготовить 

флаер с рекламой апельсинового сока по 
образцу. Рисунки для фона — в файлах 
Juice1_1.png и  Juice1_2.jpg.  

Рисунок апельсина выполнить само-
стоятельно. Шрифты для надписи подо-
брать по своему усмотрению. 
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ЛАБОРАТОРНАЯ РАБОТА № 3  
Анимация в PhotoShop 

 
Цель: научиться создавать анимированные изображения и экспортиро-

вать их в формат .gif. 
Описание работы 
Создать новый документ размером 300 × 300 пикселей (pixels) с про-

зрачным (transparent) фоном (background content) и написать любую букву, 
которая нравится.  

 
2. Сделать копию этого слоя (сочетание клавиш Ctrl+J). Сделать слой 

невидимым. На новом слое перейти в меню Редактирование → Трансфор-
мация (Edit→Transform) или выполнить сочетание клавиш Ctrl+T, а затем 
немного «сплющить» букву.  
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3. Создать дубликат второго слоя и подвинуть его немного выше  
(это можно сделать при помощи инструмента Перемещение (Move), при же-
лании можете применить Ctrl+T). Сделать невидимым предыдущий слой. 

 
4. Создать дубликат последнего слоя. Используя команду Редактирова-

ние →Трансформация (Edit→Transform) выполнить поворот буквы на не-
большой угол. Сделать невидимым предыдущий слой. 

5. Создать дубликат последнего слоя. Сделать слой невидимым. На но-
вом слое выполнить небольшой поворот буквы и сместить вверх. 
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Сделать все слои видимыми (т.е. «открыть» для всех слоев иконки «гла-
зика»). Перейти в редактор анимации: пункт меню Окно →Анимация  
(Window→Animation).  

 
6. В окне анимации в верхнем правом углу справа есть стрелка с выпа-

дающим меню, в этом меню необходимо выбрать функцию Создать кадры 
из слоев (Make Frames from layers). Затем выделить все кадры и установить 
временной интервал на 0,1 секунду. 

 
7. Сохранить оптимизированный файл (Сохранить для Web и устройств 

(Alt+Shift+Ctrl+S)) в формате .gif. 
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Задание для самостоятельной работы 
Прежде, чем приступать к созданию анимации, необходимо рассмот-

реть процесс выделения краев изображения в режиме быстрой маски. Этот 
способ неудобен тем, что выделение происходит красным цветом и в зави-
симости от выбранного изображения может быть не виден на нем. Поэтому 
для такой анимации следует выбирать рисунок, на котором мало красного 
цвета.  

1. Открыть в FhotoShop файл gollandskaya-roza.jpg. 
2. Удалить замочек в палитре слоев. 
3. Дублировать слой с рисунком 2 раза (всего получится 3 слоя) и пере-

именовать их, как показано на рисунке: 

 
4. Установить активным слой номер 3. Включить режим Быстрая маска 

(Быстрая маска находится внизу панели инструментов). В цветовой палитре 
установить цвет переднего плана – черный, цвет фона – белый. 

5. Активировать инструмент Кисть с настройками: круглая жесткая, 
размер 4-5 пикселей.  

6. Сильно увеличить масштаб изображения и аккуратно обвести края 
цветочка там, где мы хотим, чтобы он блестел (в режиме быстрой маски вы-
деление кистью должно быть красным цветом). 
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7. Если у вас что-то не получилось, делаем так: меняем в цветовой па-

литре местами цвета и кистью стираем ошибку.  
8. Как только закончили обводку, выйти из режима быстрой маски.  

(Щелчок на значке быстрой маски). 
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9. Выполнить команду Выделение → Инверсия (Select → Inverse). 

 
10. Сделать активным слой но-

мер 3. Выполнить команду Фильтр → 
Шум → Вставить шум (Filter → 
Noise → Add Noise). Настройки окна 
для слоя 3:  

11. Аналогично настроить филь-
тры для слоев номер 2 и 1. Настройки 
окна для слоев 2 и 1: 
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Выделение отменить (Ctrl + D).  
12. Перейти в окно анимации. Создать кадры из слоев. Установить 

время для каждого кадра 0,2 секунды.  
 

 
 
Воспроизвести анимацию. Сохранить полученный анимационный 

файл: Файл → Сохранить для Веб и устройств (File → Save for Web & 
Devices).  

Можно уменьшить размеры рисунка, чтобы анимация была более реа-
листичной, для этого достаточно установить 80% от исходного размера в 
окне размеров (Image Size).  

13. Сохранить файл в формате редактора. 
 
Творческое задание 
Любым способом анимировать изображение шарика из лабораторной 

работы №1. Освоить режим твиннинга (Tween – создание промежуточных 
кадров) и применить в своей работе. 
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ЛАБОРАТОРНАЯ РАБОТА № 4 
Основные инструменты редактора Inkscape 

 
Цель: знакомство с использованием графических примитивов: Прямо-

угольники и квадраты, Эллипсы и круги, Многоугольники и звезды; транс-
формирование, поворот, отражение векторного объекта; интерполяция. 

Описание работы 
Создать новый документ со следующими настройками. 
 

 
На вкладке Прилипание установить все бегунки в крайнее левое поло-

жение. 
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Для начала работы необходимо ознакомиться 
с основными приёмами работы в векторном редак-
торе Incskape по материалам с сайта: 
http://inkscape.paint-net.ru/?id=21 (или воспользо-
ваться справкой: Учебник → Incskape: основы).  

Для удобства работы необходимо смасштаби-
ровать рабочую область. 

Нарисуйте пятнадцатиконечную звезду, цвет в 
палитре RGB: ff5555; обводка чёрным цветом 
сплошной линией толщиной 2 mm, тип соединения 
отрезков обводки – острое, максимальная длина 
острия – не менее 5 mm. Затем нарисуйте эллипс 
цветом в палитре RGB 008000 с такой же, как у 
звезды, обводкой.  
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Выделите оба объекта, используя инстру-
мент Выделять и трансформировать объекты 
(черная стрелка). Откройте окно Выровнять и 
расставить объекты (Shift+Ctrl+A) и выпол-
ните команду Центрировать на вертикальной 
оси. 

Выполните интерполяцию объектов. 
 
 
 
 
 
 
 
 
 
 

Сохраните рисунок в формате редактора. 
 
 
 

Задание для самостоятельной работы 
Нарисовать пингвина по описанию. Нарисовать два круга (эллипса) 

черного цвета (в примере цвет 1а1а1аff). Выровнять вертикально. 
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Нарисовать эллипс и заполнить его линейным 
градиентом, у которого один цвет белый, другой 
353535ff. 

Нарисовать еще один бе-
лый эллипс, цвет которого по-
чти белый, например, f2f2f2ff. 
Выровнять вертикально все фи-
гуры. 

 
Нарисовать два эллипса 

цветом ссссссff — основа глаз 
пингвина. Используйте мас-
штабирование для большей 
точности рисунка. 

 
Нарисовать еще два эл-

липса меньшего размера бе-
лого цвета. Можно пользо-
ваться дублированием объек-
тов: комбинацией клавиш 
Ctrl+Dсоздать копию эллипса, 
уменьшить размер и изменить 
цвет заливки. Нарисовать 
зрачки глаз. 

Если при уменьшении размера выделенного объекта удерживать нажа-
той клавишу Ctrl, то размер изменяется пропорционально. 

Бровь. Нарисовать два эллипса, 
(можно на свободном месте рядом с 
пингвином). Для наглядности их 
можно сделать разного цвета. 

Выделить оба эллипса и приме-
нить к ним операцию Контур→Раз-

ность  или 

Ctrl + -. 
Поменять цвет заливки брови, например, 

bfbfbfff. Более точно настроить форму брови, ис-
пользуя инструмент управления узлами. 
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Чтобы нарисовать светлое пятно 
голове пингвина потребуется более 
сложный объект, который можно со-
здать из пересечения трех эллипсов, 
как на рисунке ниже.  

Inkscape умеет находить разность 
между двумя контурами, поэтому вы-
делять нужно объекты парами: крас-
ный эллипс и один синий, применить 
к ним  операцию Контур→Разность 
или Ctrl + -. 

 
Переместить пятно на голову пингвина и, используя инструмент управ-

ления узлами, придать ему нужную форму. Для более тонкой настройки 
можно добавлять или удалять узлы векторного контура. 
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Сделать заливку фигуры линейным 
градиентом: один цвет белый, другой про-
зрачный. Можно применить Размывание (в 
примере — 4,3%). 

 
Нос. Нарисовать треугольник без об-

водки. Цвет заливки — 7f8000ff. 
 
 

 
 
Используя направляющие узлов, изменить 

форму треугольника. 
 

 
 
 
 

С помощью копии этой фигуры Ctrl+D сде-
лать блик. 

 
 
 
 
 
Сделать заливку блика линейным гради-

ентом от белого цвета к прозрачному. 
 
 

 
Инструментом Рисовать кривые Безье  

и прямые линии провести линию. 
 
 
 
 

 Ре
по
зи
то
ри
й В
ГУ



41 

Сделать обводку линии 
более толстой. 

Оконтурить получив-
шийся объект командой Кон-
тур → Оконтурить обводку 
или Ctrl+Alt+C. 

 
Немного изменить форму объекта и 

сделать заливку линейным градиентом от 
белого к прозрачному. 

 
 
 

Разметить нос. 

 
Крыло. Использовать базовую 

форму Эллипс без обводки. Оконтурить 
объект Контур→Оконтурить объект или 
Shift+Ctrl+C, чтобы появились четыре 
узла. 
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Изменяя положение узлов и 
их направляющих, придать объ-
екту форму крыла. 

Сделать блик на крыле, так 
же, как сделан блик на клюве.Сде-
лать заливку линейным градиен-
том от белого к прозрачному. 
Можно установить размывание. 

 
Сгруппировать крыло с бликом. Уста-

новить его на место в рисунке. Сделать ко-
пию крыла Ctrl+D. Отразить ее горизон-
тально. Разместить на рисунке второе 
крыло. 

 
 
 
 
 

Лапки. Нарисовать эллипс с цветом 
заливки 7c7c02ff. Оконтурить эллипс 
Shift+Ctrl+C, и он будет определен че-
тырьмя узлами. 

Изменить положение узлов, как по-
казано на рисунке ниже. 
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Установить для фигуры толстую обводку цвета 5e5e18ff. 
 

 
Создать блик. Блик – это еще один эл-

липс. Сделать заливку фигуры блика линей-
ным градиентом с переходом цвета от белого  
прозрачному.  

Сгруппировать лапку и блик, Ctrl+G. 
Вторую лапку сделать путем копирования 
первой Ctrl+D. Разместить на рисунке. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Можно добавить тень: Фильтры → Свет и тень → Отбрасываемая тень. 
Сохранить рисунок в своей папке в формате редактора. Экспортировать в 
формат .png, так как он поддерживает прозрачность. 
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Творческое задание 
Аналогично описанным при рисовании пингвина приёмам рисования в 

векторном редакторе, создать рисунки. Сохранить их в формате редактора 
и в .png. 
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